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Welcome

Apple Learning Series: Secondary Math & Science provides you with materials that

help you easily integrate technology into your classroom. This Getting Started Guide

describes the contents of Secondary Math & Science, what you need to do before

you use the software, and how to install and begin using the software.

Secondary Math & Science includes the following items:

m The Secondary Math & Science CD software case

m Resources on the Secondary Math & Science Web site

m Quick Start card

Secondary Math & Science CD software case

The CD software case contains all of the software for Secondary Math & Science.

Most products include electronic documentation on the CD, such as user’s manuals

or teacher’s guides.

Note:  If you purchased this kit with a new iMac computer, you have received

additional software CDs, such as AppleWorks. The specific CDs included may vary

depending on the model of iMac. The curriculum materials include the use of some

of these CDs. If you do not have a product used in the student projects, you can

substitute another CD of the same type. For example, you can use a different

encyclopedia CD for World Book Encyclopedia or another Web page editor for 

Adobe PageMill, such as Netscape Composer which is included on the iMac.

Web site contents

The Secondary Math & Science Web site includes the following components:

Curriculum

The Web site includes student projects for both the middle school level and the high

school level. Each project provides ideas for integrating the kit software in your

classroom. You can view the student projects online or print them from the Web site.
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Read the middle school and high school Curriculum Overviews on the Web site for

detailed information about the contents and structure of the student projects and the

other curriculum resources.

Step-by-step instructions

Step-by-step instructions for tasks using the kit software and Apple technology are

included on the Web site. These detailed instructions are designed to help your

students complete project-related activities. You can download and print the files.

You need the Acrobat Reader program installed on your computer to view and print

the Step-by-Step Cards. (See “Installing Acrobat Reader” later in this document.) After

you print them, you can laminate them for durability and keep them near the

computer.

Resources

Electronic templates are provided to help you and your students complete some of

the activities in the projects. You can use these files as is or you can customize them

for your classroom needs. You can download these templates from the Web site. The

Resources area of the Web site also includes relevant QuickTime movies and

documents that can help you use the templates and projects.

From the Secondary Math & Science Web site, you can also access the Web Page

Construction Site, a collection of instructions and other resources to help you create

your own Web pages. You can download this site and use it as a template for

customizing your own instructional Web site. You can then post it on an intranet or

use it in your classroom.

Curriculum standards

The Secondary Math & Science Web site includes correlations information that shows

how the software and student projects align to curriculum standards. You can search

for correlation information by grade level, subject area, topic, and by select states.

Apple Learning Professional Development Online Course

Secondary Math & Science includes an online course that is designed to help you

learn how to use the kit software to enhance the curriculum in your classroom. You

access this course from the Secondary Math & Science Web site by clicking the

Professional Development button. The course introduces each of the software

products, presents a brief demonstration of an aspect of the software, and describes

how the software can be applied in your classroom.

Community

This area of the Web site includes forums where you can discuss the Secondary Math

& Science kit and its online course, student projects using the kit software that have

been submitted by other teachers, and teachers’ reviews of the software. You can also

access the extensive resources of Apple Learning Interchange (ALI), the Apple online

community for educators. ALI offers forums, chat rooms, lesson plans submitted by

teachers, special events, and other resources.
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First Steps

Several preliminary steps should be taken before you begin using the software in

Secondary Math & Science. These steps are described in “Before You Use the

Software,” below. You should also become familiar with Adobe™ Acrobat™ Reader, the

program you will use to read most of the electronic documentation in this kit and to

read many of the files you download from the Secondary Math & Science Web site.

See “Using Acrobat Reader,” later in this section, for detailed instructions about using

this program.

Before you use the software

Before you begin to use the software in this kit, you need to select a printer, make

sure the correct version of QuickTime is installed, and make sure that Acrobat Reader

is installed.

Select a printer

Some programs in the kit require you to have a printer selected, even if your

computer is not connected to a printer. If you have not already selected a printer,

follow these steps to do so:

1 Open the Apple (K) menu and choose Chooser.

2 In the upper-left section of the Chooser window, click to select the printer driver 

that corresponds to the kind of printer you want to use.

Note:  If your computer is not connected to a printer, select the LaserWriter 8 icon,

then click the close box to close the Chooser. You don’t have to do steps 3 and 4.
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3 In the upper-right section of the window, do one of the following:

m If you are connected to a network, click to select the name of the printer you 

want to print to.

m If you are not connected to a network, click to select the printer port or modem

port, whichever port your printer is connected to.

4 Click the close box to close the Chooser window.

For more information on setting printer options, see the manual that came with

your printer.

Installing QuickTime

To use some of the software in the kit, you need QuickTime 4.0 or later installed on

your computer. To check the version of QuickTime that is installed on your

computer, choose Control Panels from the Apple menu, then choose Extensions

Manager from the submenu. Scroll to QuickTime in the list below “Extensions.” The

version number is displayed. To install QuickTime, go to the Apple Web site at

www.apple.com/quicktime/ and follow the onscreen instructions.

Installing Acrobat Reader

Most of the electronic documentation included on the software CDs and the files you

download from the kit’s Web pages are in Adobe Acrobat format, also called “PDF”

format. To view and print these files, you need the Adobe Acrobat Reader program. In

some versions of the system software, Acrobat Reader is preinstalled on your

computer in the Applications folder.

If you purchased Secondary Math & Science without a computer, you need to check

to see if the latest version of Acrobat Reader is installed on your computer. You can

find out the version number of the Acrobat Reader program installed on your

computer by selecting the Acrobat Reader program icon, then choosing Get Info

from the File menu. The version number is displayed. You can find out the latest

version number by going to the Adobe Systems, Inc. Web site at www.adobe.com. If

the latest version is not already installed, you can download the Installer program for

free from the Adobe Web site.

Using Acrobat Reader

With Acrobat Reader, you can easily move around the documentation, search for

specific words or phrases, change the size of a page, and print any pages you want to

have as hard copy.
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Moving through a document

You can move through a document in a number of different ways:

m To go to the next page, click the Next Page button ( ) on the toolbar.

m To return to the previous page, click the Previous Page button ( ) on the

toolbar.

m To return to the first page, click the First Page button ( ) on the toolbar.

m To go to a specific page, click the page number box on the status bar at the

bottom of the main window, type the page number, and click OK. 

m To search for a specific word, phrase, or activity, click the binoculars button ( )

on the toolbar, type the information you are searching for, and click Find.

For more information about moving around in Acrobat Reader documents, see

“Navigating pages,” in the “Viewing PDF documents” section of the Acrobat Reader

electronic help system.

Changing the size of a page

To magnify or reduce the size of a page, click the box with the magnifying glass ( )

on the status bar at the bottom of the page, then select a magnification level. Refer to

“Viewing documents” in the “Viewing PDF documents” section of the Acrobat Reader

electronic help system for detailed information on other page display tools and

options.

Printing pages

You can print any pages of a PDF document while in the Acrobat Reader program.

To print specific pages using most printers, follow these steps:

1 Choose Print from the File menu.

2 Enter the page numbers as they appear at the bottom of the Acrobat Reader window.

These numbers may differ from the numbers that actually appear on the document

itself.

3 Click Print.

Using the Acrobat Reader electronic help system

For more information about using Acrobat Reader, see the program’s electronic help

system. To use the help system, choose Reader Online Guide from the Help menu,

then select the topic you want. Click “How to use this online guide” from the list at

the left of the main page to learn more about using the help system.
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Software Descriptions 
and Installation Instructions

The CD software case contains all of the software titles included with Secondary Math

& Science.

The following sections provide a brief description of each software product,

information on installing and opening the program, and ways to learn more about 

it. Use these instructions, rather than the instructions that may be in the product’s

electronic manual or Read Me file. For most of the software products, you’ll find a

technical support phone number. (The phone numbers listed in this section were

current at the time the guide was written. However, this information is subject to

change.)

Note:  Make sure not to install any version of QuickTime or Acrobat Reader that

might be included on a product CD. The product CDs sometimes include older

versions of QuickTime or Acrobat Reader. If you install an older version of QuickTime

you may have problems using the software; an older version of Acrobat Reader might

prevent you from opening electronic documentation or files you download from the

Secondary Math & Science Web site.

If you install an older version of QuickTime or Acrobat Reader by mistake, you can

easily reinstall the current version. To install QuickTime, go to the Apple Web site at

www.apple.com/quicktime/ and follow the onscreen instructions. (After installation,

you should make sure that the older version of QuickTime is no longer on your hard

disk.) To install the latest version of Acrobat Reader, go to the Adobe Systems, Inc.

Web site at www.adobe.com and follow those instructions.
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ActivChemistry from Prentice Hall

ActivChemistry is a fully interactive simulation of the ultimate chemistry lab. Students

can use the program to explore all the processes of chemistry, from atoms to test

tubes. ActivChemistry visually demonstrates a variety of concepts from periodic

trends to complex reactions.

Installing ActivChemistry

1 Insert the ActivChemistry CD into the computer’s CD-ROM drive.

2 Double-click the ActivChemistry CD icon, if necessary.

3 Double-click the HS AC Installer icon.

4 Click OK in the title screen.

5 Click Continue in the license agreement window.

6 In the dialog box that appears, drag the Install on HD icon from the left of the dialog

box to the icon for your hard disk at the right of the dialog box.

7 When you see a message that installation is complete, click Restart.

Using ActivChemistry

1 Open the ActivChemistry folder on your hard disk, if it’s not already open.

2 Double-click the ActivChemistryHS icon to open the program.

3 Click No if you see a message about setting your monitor to display 256 colors. You

do not need to adjust the monitor settings to use the program effectively.

The program opens and the Home window appears.

Learning more about ActivChemistry

ActivChemistry includes a getting started guide (which contains a brief tutorial) and a

user’s guide. The files for these documents are located in the UserDocs folder on the

CD. Double-click the GetStart.pdf icon to open the getting started guide and double-

click the UGuideHS.pdf icon to open the user’s guide.

The program also includes 17 lessons and simulations that you can open from the

Home window. Lesson 1 is an introductory tutorial that demonstrates how you use

the program’s tools and controls.

The worksheets are included on the Secondary Math & Science Web site as additional

resources.

The service and support telephone number is 201-236-7000.
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A.D.A.M. The Inside Story from A.D.A.M: Software

In A.D.A.M. The Inside Story, 3D graphics and animations illustrate human anatomy.

You can examine more than 100 layers of anatomy and point and click to identify

more than 4000 individual structures. A lively narrated tour by “Adam” and “Eve”

allows you to explore each of the body’s 12 major systems and find out how they

work. The CD also includes links to leading medical sites on the Internet; answers to

health-related questions from Dr. Harper, an online M.D.; interactive quizzes; and a

comprehensive reference section on the major body systems.

Using A.D.A.M. The Inside Story

You use A.D.A.M. The Inside Story directly from the CD. Before you use the program,

however, you first need to make sure that File Sharing is turned off. File Sharing is a

system software feature that allows you to share files with other users on a network.

To turn File Sharing off, follow these steps:

1 Choose Control Panels from the Apple menu, then choose File Sharing from the

submenu.

The File Sharing control panel window appears with the Start/Stop panel displayed.

2 If the File Sharing area says “File Sharing off,” File Sharing is already turned off. If the

File Sharing area says “File Sharing on,” click Stop to turn File Sharing off.

3 Click the control panel window’s close box when you’re done.

You are now ready to start using A.D.A.M. The Inside Story. If you turn File Sharing

on in the future, you need to remember to turn it off each time you want to use this

application.

To open A.D.A.M. The Inside Story, follow these steps:

1 Insert the A.D.A.M. The Inside Story CD into the computer’s CD-ROM drive.

2 Double-click The Inside Story 1997 CD icon, if necessary.

3 Double-click the A.D.A.M. The Inside Story icon to open the program.

4 Click OK if you see a message asking you to reset your monitor to display 256 colors.

Note that A.D.A.M. is a serious program that deals with the human body and contains

mature subject matter. Students can use a menu option to remove the fig leaves that

cover the breasts and genital areas of the human figures displayed in the program.
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Learning more about A.D.A.M. The Inside Story

A.D.A.M. The Inside Story has an electronic help system that is available when you’re

using the Anatomy feature. To use the help system, follow these steps:

1 Choose Contents from the first Help menu.

2 Click a green underlined topic to read information about that subject.

3 Click the Help Map button to see a complete list of help system topics.

4 When you’re done using the help system, click the help window close box.

If you’re using the Family Scrapbook or Animations features, click the Help button at

the bottom of the screen to see an explanation of the onscreen elements.

The service and support telephone number for A.D.A.M. The Inside Story is 

800-755-2326, ext. 3140.
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Graphical Analysis from Vernier Software

This graphical analysis tool includes a built-in spreadsheet, making it easy to

manipulate data to explore mathematical relationships inherent in experimental data

or from theoretical mathematical expressions.

Installing Graphical Analysis

1 Insert the Graphical Analysis CD into the computer’s CD-ROM drive.

2 Double-click the Graphical Analysis CD icon, if necessary.

3 Create a folder on your hard disk called “Graphical Analysis.”

4 Drag the Graphical Analysis icon, the Samples Files, GA User’s Guide, GA Teacher’s

Guide, and the GA Quick Reference Card icons from the CD window to the folder

you created on your hard disk.

Using Graphical Analysis

1 Open the Graphical Analysis folder on your hard disk.

2 Double-click the Graphical Analysis icon to open the program. 

Learning more about Graphical Analysis

Graphical Analysis includes a User’s Guide, Teacher’s Guide, and Quick Reference

card, all located in the Graphical Analysis folder on your hard disk.

The service and support telephone number for Graphical Analysis is 503-277-2299.
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Interactive Physics from MSC Software

Interactive Physics is a dynamic construction tool for physics models and simulations.

It allows teachers and students to easily create simulations and animations that

model Newtonian Mechanics without programming. The program can be used for

discovery, investigation, and demonstration, including “what if ” scenarios.

Note:  Depending on when you purchased your kit, you received either Interactive

Physics 5.0 or Interactive Physics 2000. Instructions for both versions are included

here.

Installing Interactive Physics 5.0

1 Insert the Interactive Physics 5.0 CD into your computer’s CD-ROM drive.

2 Double-click the Interactive Physics 5.0 CD icon, if necessary.

3 Double-click the Interactive Physics Setup icon.

4 Click Continue in the opening screen.

5 Click Install in the next dialog box.

6 When you see a message stating that installation was successful, click Quit.

Using Interactive Physics 5.0

1 Open the Interactive Physics folder on your hard disk, if it’s not already open.

2 Double-click the Interactive Physics 5.0 icon. The first time you use Interactive

Physics, a dialog box appears asking you to personalize your copy of the software.

3 Type your name and the serial number. The serial number is located on the CD label.

Click Accept. You can leave the Organization field blank.

4 Begin a construction in the document window or choose Open from the File menu

to select a file.

Installing Interactive Physics 2000

1 Insert the Interactive Physics 2000 CD into your computer’s CD-ROM drive.

2 Double-click the IP 2000 CD icon, if necessary.

3 Double-click the IP 2000 icon.

4 Click Continue in the opening screen.

5 Click Install in the next dialog box.

6 When you see a message stating that installation was successful, click Restart.

Note:  You’ll still need the CD to use Interactive Physics 2000 because not all of the

files from the CD have been installed on your computer.
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Using Interactive Physics 2000

1 Make sure the CD is still in the CD-ROM drive.

2 Open the Interactive Physics folder on your hard disk, if it’s not already open.

3 Double-click the Interactive Physics 2000 icon to open the program. The first time

you use Interactive Physics 2000, a dialog box appears asking you to personalize your

copy of the software.

4 Type your name and the serial number. The serial number is located on a sticker on

the CD sleeve. You can leave the Organization field blank. Click Accept.

5 Begin a construction file in the document window or choose Open from the File

menu to open an existing file.

Learning more about Interactive Physics (both versions)

Interactive Physics includes an electronic help system. To use the help system,

choose IP Guide and Workshop from the Help menu. You can select from a list of

topics, an index, or find text by typing your own topic.

The help system also includes a workshop that contains six projects. Each project

guides you through creating a basic model. It provides instructions for applying

changes to the model, and suggestions for further exploration on your own. Select

Workshop from the list of help topics to open these projects.

The service and support telephone number for Interactive Physics is 800-766-6615.
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Logal Algebra Animator from Riverdeep

Part of the Tangible Math Series, Logal Algebra Animator allows students to create

and observe animations of objects whose movements are determined by function

equations. Functions are represented by mapping diagrams, tables of values, and

graphs. Variables used include time (t), horizontal and vertical distances (x and y),

height or vertical stretch (h), and width or horizontal stretch (w). The program is

designed to help students to use mathematics to analyze and solve real-world

problems.

Installing Algebra Animator

1 Insert the Algebra Animator CD into the computer’s CD-ROM drive.

2 Double-click the Algebra Animator CD icon, if necessary.

3 Double-click the Algebra Install icon to start the installation process.

4 Read about the types of installation that are available for the teacher and student

computers, then click Continue.

5 Drag the Student Hard Disk icon or the Teacher Hard Disk icon (depending on which

type of computer you are installing the files on) from the left side of the installation

dialog box to your hard disk icon on the right side.

6 You may see a message about whether or not you want to use a database feature that

tracks student work. Click Yes if you want to use it and respond to other onscreen

messages about the database.

7 Click Quit when you see a message stating that installation was successful.

Using Algebra Animator

1 Open the LOGAL MATH folder or the LOGAL MATH Teacher folder on your hard disk. 

2 Double-click the Algebra Animator icon to open the program.

A new Algebra Animator document appears.

Learning more about Algebra Animator

Algebra Animator includes a user’s guide. To open the user’s guide, choose Open

User’s Guide from the File menu when Algebra Animator is open.

Algebra Animator also includes an electronic help system. To use the help system,

click the ? in the toolbar on the left of the screen. When you move the pointer over

an onscreen element, information about that element appears in a window on your

screen. Click the help window close box when you’re done using the help system.

The service and support telephone number for Algebra Animator is 888-564-2999.
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Logal Geometry Inventor from Riverdeep

Students can use Logal Geometry Inventor to construct, manipulate, and observe

geometric objects. With this product, part of the Tangible Math series, students can

explore plane geometry from the synthetic (Euclidean), analytic, and

transformational perspectives.

Students can informally explore many important mathematical ideas embedded in

geometry by linking figures to built-in tables, spreadsheets, and graphics that

simultaneously update and display information as figures are moved.

Installing Geometry Inventor

1 Insert the Geometry Inventor CD into the computer’s CD-ROM drive.

2 Double-click the Geometry Inventor CD icon, if necessary.

3 Double-click the Geometry Install icon to start the installation process.

4 Read about the types of installation that are available for the teacher and student

computers, then click Continue.

5 Drag the Student Hard Disk icon or the Teacher Hard Disk icon (depending on which

type of computer you are installing the files on) from the left side of the installation

dialog box to your hard disk icon on the right side.

6 You may see a message about whether or not you want to use a database feature that

tracks student work. Click Yes if you want to use it and respond to other onscreen

messages about the database.

7 Click Quit when you see a message stating that installation was successful.

Using Geometry Inventor

1 Open the LOGAL MATH folder or the LOGAL MATH Teacher folder on your hard disk. 

2 Double-click the Geometry Inventor icon to open the program.

A new Geometry Inventor document appears.

Learning more about Geometry Inventor

Geometry Inventor includes a user’s guide. To open the user’s guide, choose Open

User’s Guide from the File menu when Geometry Inventor is open.

Geometry Inventor also includes an electronic help system. To use the help system,

click the ? in the toolbar on the left of the screen. When you move the pointer over

an onscreen element, information about that element appears in a window on your

screen. Click the help window close box when you’re done using the help system.

The service and support telephone number for Geometry Inventor is 888-564-2999.
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Rainforest Researchers from Tom Snyder Productions

Working in teams, students take on the roles of an ecologist, an ethnobotanist, a

taxonomist, and a chemist as they complete two challenging assignments that involve

rainforest plants. The teams explore the Indonesian rainforest, and learn about

tropical rainforest issues, current research efforts, plant life cycles, and adaptations 

of organisms. Video and onscreen instructions help students analyze information 

and collaborate to make decisions and solve the problems they face as rainforest

researchers.

Installing Rainforest Researchers

1 Insert the Rainforest Researchers CD into the computer’s CD-ROM drive.

2 Double-click the Rainforest CD icon, if necessary.

3 Drag the “Rainforest v1.1” icon to the icon for your hard disk.

You’ll still need the CD to use Rainforest Researchers because not all the files from

the CD have been installed on your computer.

Using Rainforest Researchers

1 Make sure the CD is still in the CD-ROM drive.

2 Double-click the “Rainforest v1.1” icon on your hard disk to open the program.

3 Click New to start a new session.

Learning more about Rainforest Researchers

A teacher’s guide is included in the Documentation folder on the CD. The

Documentation folder also includes files for the four student booklets and student

worksheets. You can print each booklet and photocopy them to distribute them to

your students or you can order the booklets in printed form by calling 800-342-0236.

Rainforest Researchers also has an electronic help system. To use the help system,

follow these steps:

1 Click Tips at the bottom of the screen to see a list of questions about the program.

2 Click a question you would like answered. The answer appears on the right side of

the screen.

3 When you’re done viewing the help information, click Go Back in the lower-left

corner of the screen.

The service and support telephone number for Rainforest Researchers is 

800-342-0236.
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Starry Night Backyard from Sienna Software

With Starry Night Backyard, you can learn to identify planets, stars, constellations,

and other objects in the sky. You can view the sky from where you live or from other

locations, including other planets. The application lets you see how the sky looked or

will look at different times of day, or dates, from 4713 BC to 9999 AD.

Installing Starry Night Backyard

1 Insert the Starry Night Backyard CD into the computer’s CD-ROM drive.

2 Double-click the Starry Night Backyard CD icon, if necessary.

3 Drag the Starry Night Backyard folder to your hard disk. 

Note:  Do not install either QuickTime or Acrobat Reader from the Starry Night

Backyard CD. Current versions of those files are already installed on your computer.

Using Starry Night Backyard

1 Open the Starry Night Backyard folder on your hard disk.

2 Double-click the Starry Night Backyard 3.0 icon to open the application.

3 The first time you use the program a dialog box appears asking for your home

location. Click Lookup, select the location closest to your school, then click OK. Click

Set Home Location.

4 Click OK if you see a message about changing the display of colors on your monitor.

5 In the registration dialog box that appears the first time you use the program, type

your name (optional). You do not need to type a registration number. Click OK.

Learning more about Starry Night Backyard

A user’s manual is located in the Starry Night Backyard folder on your hard disk. You

can also access an online manual (which is somewhat different from the user’s

manual) by choosing On-line Starry Night Backyard from the Help menu when the

program is open. The manual opens in your browser software.

The service and support telephone number for Starry Night Backyard is 

416-410-0259.
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StudyWorks! for Schools from MathSoft

This CD is a special education version that combines two products, StudyWorks for

Math and StudyWorks for Science. It provides a a full-screen graphing and calculating

tool, a math word-processing program, a computer algebra system, and a

comprehensive set of facts and formulas. In the program’s Resource Center, you can

access hundreds of math and science examples to use for exercises, tutorials,

explorations, and labs. 

Installing StudyWorks! for Schools

1 Insert the StudyWorks! for Schools CD into the computer’s CD-ROM drive.

2 Double-click the StudyWorks for Schools CD icon, if necessary.

3 Double-click the Install icon.

4 Click Install in the dialog box that appears.

5 Click Continue when you see a message about restarting your computer after

installation.

6 Click Restart when you see a message about restarting your computer.

You’ll still need the CD to use StudyWorks because not all the files from the CD have

been installed on your computer. 

Using StudyWorks! for Schools

1 Make sure the CD is still in the CD-ROM drive.

2 Open the StudyWorks folder on your hard disk.

3 Double-click the StudyWorks icon to open the program.

4 In the registration dialog box, type your name, serial number, and email address

(optional). The serial number is located on the CD label. Click OK.

5 Make a selection from the StudyWorks Resource Center screen.
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Learning more about StudyWorks! for Schools

Click Quick Tour from the Resource Center screen to take an introductory tour of the

program.

The Teacher’s Resource Guide includes ideas for using the program in the classroom

or the lab. To read this guide, click to select Teacher’s Resource Guide from the

Resource Center screen. A teacher’s guide and a user’s guide are also included with

the program. The files for these guides are located in the Documentation folder on

the CD.

Note:  Do not install the version of Acrobat Reader that is included in the

Documentation folder on the CD. A newer version of that program is already

installed on your computer. 

StudyWorks also includes an electronic help system. To access the help system, click

the Help ? button on the toolbar.

The service and support telephone number for StudyWorks is 617-577-1778.
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Tabletop from The Learning Company

Tabletop is a powerful visual tool for storing, exploring, and analyzing data. Tabletop

provides an animated, interactive environment in which users can group, rearrange,

sort, and compare data for diverse topics such as chemical compounds, geometric

figures, or insects. At the click of a button, students can put the data into a graph,

change the parameters of the graph, and watch the data (in the form of icons) move

across the computer screen.

Installing Tabletop

1 Insert the Tabletop CD into the computer’s CD-ROM drive.

2 Open the Tabletop Install CD icon, if necessary.

3 Double-click the Installer icon.

4 In the screen that appears, click Continue.

5 Click Install in the next dialog box and follow the onscreen instructions to complete

the installation.

Using Tabletop

1 Open the Tabletop folder on your hard disk.

2 Double-click the Tabletop icon.

3 Click anywhere in the opening screen to start using Tabletop. The first time you use

Tabletop, a dialog box appears asking you to personalize your copy of the program.

4 Type your name and click OK. ( You can leave the Organization field blank.)

5 To open an existing database, choose Open from the File menu, or double-click the

file in the Tabletop Data folder.

6 To create a new database, choose New Database from the File menu.
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Learning more about Tabletop

Electronic files for a teacher’s guide, a user’s manual and three guided tours are

included on the Tabletop CD in the Tabletop Documentation folder. The guided

tours show users how to explore a database and create plots (Tour 1); create a

database and make axis plots (Tour 2); and customize and present plots (Tour 3).

Click the User’s Manual icon, the Teacher’s Guide icon, or the Tabletop Tours icon to

open the document you want. If you have opened the Tabletop Tours file, click the

bookmark in the list at the top left of the screen to go to the tour you want.

Tabletop also contains an electronic help system. To use the help system, follow

these steps:

1 Choose Help from the Windows menu.

2 Click a topic in the list on the right side of the window; then click Help to see

information on that topic.

3 Click Previous or Next to scroll through the list of help topics, or click Index to see

the main screen again.

4 When you’re done using the help system, click Done.

The service and support telephone number for Tabletop is 800-723-6322.
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Work It Out: Levels 1 and 2 from Envision Interactive

Students use Work It Out to apply math concepts to real-world problems, such as

how high a soccer ball can be kicked or how the school lunch schedule impacts the

class schedule. The Work It Out Level 1 CD contains easier problems and the Level 2

CD more difficult ones. The problems are based on concepts taught in Algebra I 

and II and Geometry and are designed to support the NCTM Standards. The program

includes 70 problems and more than 200 questions as well as video segments and

graphics.

Installing Work It Out

The steps for installing each level are the same.

1 Insert the Work It Out: Level 1 or Level 2 CD into the computer’s CD-ROM drive.

2 Double-click the Work It Out Level 1 or Level 2 CD icon, if necessary.

3 Double-click the Setup Level 1 or Setup Level 2 icon.

A series of dialog boxes appears in which you select settings for the program.

4 Click Next in the first dialog box that appears.

5 Select whether you are installing the program on a single computer or on a network

server, then click Next.

6 Select whether you want students to save their work on a floppy disk or on the hard

disk, then click Next.

7 Click Next in the installation dialog box to install the program on your hard disk. 

(If you do not want the program to reside in the Work It Out folder on your hard

disk, click Change Location and type where you want it installed; then click OK. You

cannot change the program’s location after installation.)

8 Click Finish to complete the installation.

9 Click OK when you see a message that installation is complete.

10 Restart your computer by choosing Restart from the Special menu.

Using Work It Out

1 Open the Work It Out folder on your hard disk.

2 Double-click the Start Work It Out icon for the level you want to use.

3 Press the Space bar when the opening screen appears.

4 In the Student Login screen, you need to select your name and password. If you

want, choose Guest for your name and type GUEST for the password. As the

administrator, you can assign users IDs and passwords. To log in as the administrator,

choose Administrator from the pop-up menu and type WORKIT for the password.

(See the teacher’s guide for information on setting up user names and passwords.)

Click OK.

5 Click OK in the next dialog box.
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Learning more about Work It Out

A tutorial that demonstrates the features of Work It Out is included. Double-click the

Tutorial icon in the Work It Out folder to view the tutorial.

Work It Out includes a teacher’s guide and a student guide, which are located in the

Teacher/Student_Guide folder on the CD.

Work It Out also includes an electronic help system. Click the button with the

question mark at the bottom of the screen to open the help system. Click to select a

topic on the left to see information on that subject. Click the Close button when

you’re done using the help system.
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